Release Notes
The Discovery Series™
Quantity One® 1-D Analysis Software
Version 4.6.1
This document has the following sections:
1. New Features in Version 4.6.1
2. New Features and key Fixes in Version 4.6.0
3. Recommended System Configuration
4. Installation
5. Known Issues
6. Reporting Feature Requests to Bio-Rad
7. Uninstalling Quantity One
8. Installing Adobe® Reader® for viewing electronic documentation

1. NEW FEATURES IN VERSION 4.6.1
1. Added support for the new Molecular Imager PharosFX.

2. NEW FEATURES AND KEY FIXES IN VERSION 4.6.0
1. Added support for the new EXQuest Spot Cutter. The new design features:
•

Setup and Calibration Wizard - To quickly and easily calibrate the instrument.

•

Manual Excision - The ability to manually cut spots from a gel or membrane using the new
Manual Excision tool.

•

Lane/Volume Excision – The ability to cut spots from defined lanes or volumes (band
excision) using the new Lane/Volume Excision tool.

2. Added the ability to use local groups in CFR mode.
3. If you have used Quantity One in CFR mode in a prior release, you must delete the
Onedpref.dbs file before installing Quantity One version 4.6.0. This file is found in
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C:\Documents and Settings\All Users\Application Data\The Discovery Series\fixed.prm. This
fixes an issue with CFR module destroying predefined and user defined standards.
4. Fixed the problem with Network Hardware Security key (netHASP) spontaneously switching
ID’s.

3. RECOMMENDED SYSTEM CONFIGURATION
This software is supported on Windows XP and Windows 2000, or on a Macintosh PowerPC running
Mac OS 9.2 or Mac OS X 10.2 and 10.3.
The computer memory requirements are mainly determined by the file size of the images you will scan
and analyze. High-resolution image files can be very large. For this reason, we recommend that you
archive images on a network file server or high-capacity removable disk.
PC

The following is the recommended system configuration for installing and running on a PC:
Operating system: Windows 2000
Windows XP
Processor:

Pentium 333 MHz or faster.

RAM:

≥ 256 MB for all Bio-Rad imaging systems.

Hard disk space:

≥ 3 GB

Monitor:

17" monitor, 1024 x 768 resolution (required), True color.

USB Port:

Required for the Hardware Security Key (HSK).

Printer:

Optional.

Macintosh

The following is the recommended system configuration for installing and running on a Macintosh:
Operating system:

MacOS 9.2, MacOS 10.2 and 10.3.

Processor/Model:

PowerPC G3 processor or faster.

RAM:

≥ 256 MB for all Bio-Rad imaging systems.

Hard disk space:

≥ 3 GB

Monitor:

17" monitor, 1024 x 768 resolution (required), Millions of colors.

USB Port:

Required for the Hardware Security Key (HSK).

Printer:

Optional.
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Note: The default amount of memory assigned to the application on the Macintosh is 128 MB. If the
total RAM in your Macintosh is 128 MB or less, you should reduce the amount of memory
assigned to the program to 10 MB less than your total RAM. With the application icon
selected, go to File > Get Info in your Finder to reduce the memory requirements for the
application.
See your Macintosh computer documentation for details.

4. INSTALLATION
4.1. Hardware Security Key (HSK)
The Discovery Series software is password-protected using a Hardware Security Key (HSK), which is
included in your software package. You must attach the Hardware Security Key to your computer
before you can run the software.‘
Before proceeding with installation, plug the HSK into any available USB port on your computer.
(Windows 2000 – If the Found New Hardware dialog displays, click Cancel.)
The code for the HSK is EYYCY, which is printed on the key itself. Use this code to identify the HSK
that belongs to The Discovery Series software.
Note: Initial installation of a network server requires the Hardware Security Key included in the
software package. Installation of an additional Network Client User to a Network License
Server System does not require an HSK. Please refer to the Network License Installation
Guide that ships with Network License.
4.2. Installing Quantity One on a PC
Note: You must be a member of the Administrators group to install The Discovery Series software.
Insert The Discovery Series CD-ROM. The installation wizard will start automatically. (If the CD does
not auto-start, click Start in your taskbar then click Run. In the Open field type d:\setup.exe where d is
the letter of your CD-ROM drive.) Select the software application you want to install. On each panel,
click Next when you are ready to proceed. You must accept the license agreement to continue with
installation.
Enter your name and the name of your organization. Select whether you want to install this application
for you alone, or make it available for all users on this computer.
The next panel displays the destination folder for the installation. To specify a different location than the
default, click Browse.
The Select Features panel lists all the features and instrument drivers available for installation. The
software application, the User Guide, and the HSK drivers are selected by default. A red X indicates
features not selected for installation. To modify the installation status of a feature, click the feature and
select an installation option from the list.
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Important! If the computer is going to be used to acquire images from Gel Doc™ XR, ChemiDoc™
XRS, or the VersaDoc™ system, install the driver for your particular imaging device now.
When you are satisfied with your feature selections, click Next.
When installation is complete, click Finish to close the installation wizard.
The application program will be placed in the Bin folder located in The Discovery Series folder. An
additional folder for storing sample images is also located in The Discovery Series folder. User profiles
will be created and stored in the Documents and Settings folder for each user.
The installer places a shortcut to the application and user guide on your desktop and creates a The
Discovery Series folder in Programs on your Windows Start menu.
After installation, you must reboot your computer before using an imaging device.
Note: If you are installing in a Windows 2000 environment, you must start the application as
administrator before allowing any other user access to the application.
4.2.1. Shared Software Installation Folder

Under Windows, the other member of The Discovery Series software family (PDQuest™) may be
installed in the same directory as Quantity One. Be aware that these applications share some files, so be
sure to read the section on uninstalling if you want to remove one of the applications.
4.3. Installing Quantity One on a Macintosh
Insert The Discovery Series CD-ROM. The TDS-Mac folder opens on your desktop, displaying the
installers for The Discovery Series applications. Double-click the installer for your application. You must
accept the license agreement to proceed with installation. The ReadMe contains important information
about the HSK. Click Continue.
The installation wizard lists the types of installations in the pull down list. If you want to install the
application and documentation only, select Easy Install from the list.
If you want to install drivers as well, select Custom from the pull down list. (Remember to also select the
application in custom install.)
Note: If the computer is going to be used to acquire images from Gel Doc XR, ChemiDoc XRS, or
the VersaDoc system, then select the driver for your particular imaging device now.
Install Location identifies where the application will be installed. If you want to specify a different
location, click the pull-down button.
Click Install to proceed. Once installation is complete, click Quit. To return to the installer, click
Continue.
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5. KNOWN ISSUES
5.1. Installation
1. If you are running the installation program from a network file server and receive an error message,
copy the installer to your computer and run the installation program from there.
2. After installing The Discovery Series software, you must re-boot your computer before
attempting to use an imaging device.
3. In Windows 2000 and XP, SCSI devices cause the Found New Hardware Wizard to be
launched each time the computer is booted. You can stop this Wizard from appearing
unnecessarily by performing the following procedure:
a. When the Found New Hardware Wizard appears, click Next.
b. In the Install Hardware Device Drivers window, select “search for a suitable driver for
my device”, and click Next.
c. In the Locate Driver Files window, clear all checkboxes for optional search locations,
and click Next.
d. In the Driver Files Search Results window, select “disable the device”, and click Finish.
This procedure does not disable the installed SCSI device, but it does stop the Found New
Hardware Wizard from appearing unnecessarily.
4. In Windows 2000, you must run the application once as administrator before another user may
open the application.
5.2. Imaging Devices
1. Mac only: The Gel Doc XR is not supported on Mac OS 9.2.
2. PCI card and driver installation for Gel Doc XR, VersaDoc, ChemiDoc XRS, and Spot Cutter:
Follow these steps for installation of the PCI card and driver.
Windows
Important: Install the drivers before you install the PCI card.
a) Run the installation wizard for The Discovery Series. If you have already installed
Quantity One, select Modify, and click Next. Select the driver for your device.
Click Next to complete the driver installation.
b) Turn off the machine and install the PCI card.
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c) When the machine restarts the hardware wizard will find the appropriate driver.
Note that under Windows XP you will get a Found new Hardware dialog box, click
Next, and Windows will find the correct driver.
Macintosh
a) Insert The Discovery Series CD and double click the Installer for Quantity One.
Select Custom Install from the pull down list. Select the driver for your device.
Click Install to complete the driver installation.
b) Restart your machine.
Note: With Macintosh installation, you can choose to install the PCI card either before
or after you install the drivers.
3. ChemiDoc EQ: When using the ChemiDoc EQ Live Acquire feature, image background can
build up in the successive exposures, so that in later exposures the level of background can
approach saturation. To avoid this, you should take no more than 10 exposures of any image
using Live Acquire. If background saturation is still a problem with fewer than 10 exposures,
you can change the minimum DAC offset value in the ChemiDoc EQ Options dialog, as
described below:
3.1. Close the iris on the ChemiDoc EQ camera and collect a 0.1-second exposure with no
light source. In the resulting image, select Plot Density in Box from the View > Plot Density
submenu and drag a box over a large area of the image. Note the average density value in
the box (it should be between 5 and 20 counts).
3.2. Open the ChemiDoc EQ Options dialog, and raise the minimum DAC setting by one or
two counts, from 60 to 61 or 62.
3.3. Repeat 1.1 above. The average background counts in the dark image should have
decreased.
3.4. Repeat the above steps until the average background counts in the dark image are above
zero, but less than 2.
3.5. Now when you capture an actual image using Live Acquire, the added background counts
in each exposure should remain low and not approach saturation. Note that while you can
increase the minimum DAC setting until the average background count in a dark image is
zero, in actual images weak signals may be masked.
4. Gel Doc EQ and ChemiDoc EQ: If you quit Quantity One while the Gel Doc EQ or ChemiDoc
EQ is in the process of acquiring an image, the Macintosh version of the application will report
an error at the end of the quit process (the error will occur in the Windows version too;
however, it will not be reported). You will first be prompted to save all your unsaved images, so
this error will not result in any loss of data.
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5. All imaging devices on the Macintosh: If you select Make Backup Copy in an imaging device
acquisition window, you should enter a file name of no more than 22 characters when you are
prompted to save your image capture. This is because the Macintosh only allows file names of
31 characters, and Quantity One automatically appends “ (backup)” to the backup file name. If
your file name is more than 22 characters, characters will be deleted from the end of the file
name.
6. GS-800: If you are using older versions of the GS-800, the reflective step tablet will remain
non-operational in Quantity One. Contact Bio-Rad for an upgrade in your GS-800 firmware to
add reflective support.
7. Molecular Imager FX™, Fluor-S™, Fluor-S MAX™, or VersaDoc: On Macintosh only, if you
are creating a Custom application using the FX, Fluor-S, Fluor-S MAX, or VersaDoc, when
you click on a filter button to select a filter, the Custom dialog box may disappear. Simply select
the filter and the dialog box will reappear.
8. Fluor-S, Fluor-S MAX, Fluor-S MAX2 ™: Exposure time info incorrect using Live Acquire.
The image info for intermediate images shows the exposure times as the total exposure time for
the entire Live Acquire rather than the actual intermediate exposure times.
9. GS-700: If you click on More Options with Calibration On not selected, then select Calibration
On, the Calibrate Now and Edit Step Tablet buttons will not appear active. These will appear
active if you close the More Options dialog box and reopen it.
10. Personal Molecular Imager FX and Molecular Imager FX imagers: If the ACQUIRE button is
clicked while the filter wheels are moving to their home position (such as when the door is
opened and then closed) you may get an “Unknown Imager Fault” error in the software and a
“fault 13” error on the imager LCD screen. To avoid these errors, wait for the filter wheels to
home before clicking the ACQUIRE button.
5.3. Spot Cutter
1. To protect the cutting tip, the outer half-inch of the gel tray is considered off the cutting stage.
Be sure none of the spots you want to cut are in this area, or the spot cutter will not be able to
cut them.
2. If you are using the spot cutter for excision in both PDQuest and Quantity One, it is possible to
open the spot cutter interface in both applications simultaneously causing them to crash.
3. Hydration parameters cannot be changed once the cut run begins. To change hydration
parameters, you need to re-acquire the image.
4. In Analysis Set Excision Control, you must select hydration before beginning the cut run.
5. Macintosh only – Control of the Spot Cutter is not supported.
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5.4. Other Features
1. If you adjusted the Color settings in version 4.1 or earlier of Quantity One, then installed version
4.6.0 in the same directory, image colors will appear inverted (only the colors are inverted; not
the data). To correct this problem, select Color from the Edit menu and click on the Reset
button in the dialog box.
2. Windows only: The image viewing tools (Grab, Zoom In/Out, Zoom Box) are active when the
Background Subtraction window or Transform window is opened. However, if you attempt to
select these tools while the Transform or Subtract Background window is active, you will
receive an error message.
3. Windows only: When you open some windows under lower screen resolutions (e.g., the
minimum recommended resolution of 1024 x 768), the top line of the report may appear cut off
inside the report window (it will print normally). In most cases, this can be resolved by resizing
the report window; however, some report windows cannot be resized. The problem can be
corrected by selecting a higher screen resolution.
4. Some annotation formatting (such as superscript and subscript) may be lost if you transfer an
image with annotations between a Macintosh and a PC.
5. When generating a similarity report (Phylogenetic Tree, Similarity Matrix, Compare Lane
Images) in Quantity One, the comparison options (Reports > Comparison Options) can
fundamentally change how similarity is calculated. However, these settings are not noted in the
reports themselves.
6. If you display the Volume Regression Curve using the command on the Reports menu, the curve
may not reflect the type of background subtraction (global or local) specified in the Volume
Report Options dialog. To avoid this problem, click on the Show Curve button in the Volume
Report Options dialog to display the Volume Regression Curve.
7. Mac only: FreeHand Overlays - After scrolling image, mouse input intermittently freezes forcing
the user to lose unsaved changes and re-start the application.
8. False saturated value warning on VersaDoc. As the imaging time is increased, there comes a
point where the detect saturated pixels feature will render the entire image red. As the time
increases, the degree of saturation decreases to the point where none is shown.
9. Windows only: Colony counting images offset. When running at 1024x768 resolution, colony
counting images (density and image window) appear noticeably offset within the panel.
10. Colony counting cross platform – Intermittent error when file is re-opened from File menu or
Toolbar. To avoid this problem, open the file from the colony panel.
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11. Overlays are not repainted when filter dialogs are moved or dismissed. To fix this problem, resize the image window.
12. To reliably save colony changes, click the Save button on the main application toolbar instead
of the button in the colony dialog box.
13. Install the latest graphics driver for using the 3D Viewer. If, after updating your drivers, you are
still having problems, select Disable hardware acceleration for 3D viewer. This allows Quantity
One to emulate a graphics driver to render a 3D image. Note that this will reduce performance
in the 3D Viewer.
14. To increase the performance of the 3D Viewer, select only a small portion of your image.
15. Microsoft Office XP does not support 16 bit TIFF images. If you plan to import your images
into an Office XP application, you must export them as 8 bit images.
16. Mac only: Quantity One cannot open files with names longer than 31 characters. You must first
rename the file using fewer characters, and then open the file.
17. Mac only: When opening files from a network using OS 9.2, the file opens with a locked tag.
This causes the application to open the Save as dialog box when you attempt to save the file.
However, this does not prevent you from saving the file with the original name.

6. REPORTING FEATURE REQUESTS TO BIO-RAD
The installer for Quantity One also installs Solobug (TDS) in The Discovery Series directory (Windows)
or Quantity One folder (Macintosh). We would like you to use this program to request features, request
design changes, or report problems for Quantity One.
To use Solobug, open Solobug, enter your information and a description of the request, and click on
Save. This will create a report that you can attach to an e-mail and send to Bio-Rad.
Please send your Solobug files to Bio-Rad at:
LSG.TechServ.US@Bio-Rad.com (in the U.S.)

7. UNINSTALLING QUANTITY ONE
7.1. Windows
If you need to uninstall The Discovery Series for any reason, go to Add/Remove Programs in the
Control Panel. Highlight the application you want to remove and click Remove.
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Note: Uninstalling The Discovery Series software does not remove any system files located in
Application Data folder(s) in Documents and Settings. If you want to remove these files as well,
you must do so manually.
7.2. Macintosh
Insert The Discovery Series CD-ROM. The TDS-Mac folder opens on your desktop, displaying the
installers for The Discovery Series applications. Double-click the installer for your application. In the
installer screen, select Uninstall from the pull down list.

8. Installing Adobe Reader
The Discovery Series Software User Guides are available in electronic format as PDF files on the CD.
To view the user guide for your application, you must have Adobe Reader installed on your machine.
The Discovery Series includes the latest Reader available from Adobe.
8.1. Installing Adobe Reader for Windows
Insert The Discovery Series CD-ROM into your computer. The installer should start automatically.
Click Explore CD. If the CD does not auto-start, or is already in your CD drive, use Windows
Explorer to open the root directory on the CD-ROM. Navigate to Other Software\Adobe Reader.
Double click setup.exe. Follow the installation instructions.
Once the Reader is installed, to view the user guide, go to Start>Programs>The Discovery Series and
click Quantity One Manual.
8.2. Installing Adobe Reader on a Macintosh
Insert the TDS CD-ROM into your computer. Double click the TDS_MAC icon on your desktop.
open the Other Software folder. Double click the icon for your particular operating system (MacOS 9
or MacOS 10). Follow the installation instructions.
Once the Reader is installed, to view the user guide, go to the Quantity One folder in the Applications
folder and double click the Quantity One manual icon.
Trademarks
Adobe and Adobe Reader are trademarks of Adobe Systems, Inc.
Macintosh, Mac, and PowerPC are trademarks of Apple Computer.
Office XP, Windows, Windows 2000, and Windows XP are trademarks of Microsoft Corp.
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